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chapter 1

Introduction
Welcome to the Preferences Primer. This docu-
ment provides important information about 
Preferences in Pro Tools®.

Chapter 2, “Preferences” includes:

The differences between global (system-wide) 
and local (current session) preferences.

Detailed descriptions of the preferences in 
each tabbed Preferences page.

Chapter 3, “Noting Your Preferences” includes:

Tips for saving your preferences settings prior 
to installing an upgrade.

Tables for noting your current preferences set-
tings.

When you upgrade to a higher version of 
Pro Tools, your preferences are reset to the 
factory default settings.
Chapter 1: Introduction 1
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chapter 2

Preferences
The settings in the Preferences dialog define 
how Pro Tools features work by default. The 
Preferences dialog has several tabbed pages in 
which you can specify your preferred settings 
for various types of session parameters. Each 
Preferences page is covered in detail in this 
chapter.
To change Pro Tools preferences:

1  Choose Setup > Preferences.

2  Click the tab for the page that has preferences 
you want to change. 

3  Change preferences as desired.

4  Click OK to save your changes and close the 
Preferences dialog.
Figure 1.  Pro Tools Preferences dialog on a Pro Tools|HD system (Display Preferences page shown)
Chapter 2: Preferences 3
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Global and Local Preferences
Pro Tools preferences are either global (system-
wide) or local (for the current session only). 

Global (System-Wide) Preferences

Global preferences are applied to all sessions. 
These preferences become the default prefer-
ences for any existing sessions that you subse-
quently open or any new sessions that are cre-
ated.

Local (Current Session) Preferences

Local preferences are applied to the current ses-
sion (if one is open). Local preferences are not 
applied to older sessions that are subsequently 
opened.

Preferences and New Sessions

New sessions use global preference settings, plus 
the most recent local preference settings. The 
most recent local settings refer to the last open 
session (unless subsequent changes were made 
in the Preference dialog from the application 
window).

Local (Current Session) 
Preferences List

All preferences are global, except for the follow-
ing, which are local:

• Display Preferences

• Edit Window Default Length

• Always Display Marker Colors

• Default Track Color Coding options

• Default Region Color Coding options
Preferences Primer
• Operation Preferences

• Custom Shuttle Lock Speed

• Back/Forward Amount (Pro Tools HD only)

• QuickTime Playback Priority options

• PEC/Direct Style Input Monitoring 
(Pro Tools HD only)

• DestructivePunch File Length (Pro Tools 
HD only)

• Editing Preferences

• None

• Mixing Preferences

• Coalesce Trim Automation Options 
(Pro Tools HD only)

• Processing Preferences

• Convert Imported “WAV” Files To 
AES31/BroadcastWave

• MIDI Preferences

• Play MIDI Notes When Editing

• Display Events as Modified by Real-Time 
Properties

• Automatically Create Click Track in New 
Sessions

• Default Thru Instrument

• Pencil Tool Resolution When Drawing 
Controller Data

• Delay for External Devices Options 
(Pro Tools HD only)

• Synchronization Preferences

• None



Display Preferences

Basics Section

Track Position Numbers Stay with Hidden 
Tracks When selected, tracks keep their track 
numbers even when hidden. When not se-
lected, numbers are only assigned to tracks that 
are shown. In this case, shown tracks are then 
numbered sequentially, and hidden tracks are 
not numbered.
Tool Tips Display Options

Function Configures Tool Tips to show the basic 
function of the item.

Details Configures Tool Tips to show the com-
plete name of an abbreviated name or item 
(such as a track name). Details view can also 
show the hidden or abbreviated value of param-
eters, as well as input and output assignments. 

Edit Window Default Length

This preference sets a default length for the Edit 
window in hours, minutes, seconds, and frames 
(Pro Tools HD or Pro Tools® LE with Complete 
Production Toolkit or DV Toolkit™ 2 only). This 
is useful if you want to assemble a session of a 
particular length or leave extra room to expand 
the Edit window’s work area in your session. The 
maximum length is 12 hours and 25 seconds at 
48 kHz, and proportionally less at higher sam-
pling rates. For best scrollbar sensitivity, set the 
length to slightly longer (a minute or more) 
than the total session or song length.
Chapter 2: Preferences 5
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“Organize Plug-in Menus By” Options

These option customize how plug-in menus are 
organized in the Insert selector or Plug-in selec-
tor.

Flat List Organizes plug-ins in a single list, in al-
phabetical order.

Category Organizes plug-ins by process category 
(such as EQ, Dynamics, and Delay), with indi-
vidual plug-ins listed in the category submenus. 
Plug-ins that do not fit into a standard category 
(such as the DigiRack Signal Generator), or 
third-party plug-ins that have not had a cate-
gory designated by their developers, appear in 
the Other category. Plug-ins can appear in more 
than one category. 

Manufacturer Organizes plug-ins by their manu-
facturer (such as Bomb Factory®, Digidesign®, 
Focusrite, or TL Labs), with individual plug-ins 
listed in the manufacturer submenus. Plug-ins 
that do not have a Manufacturer defined will ap-
pear in the “Other” manufacturer folder. 

Most Digidesign-distributed third-party plug-ins 
will be grouped under Digidesign when Manu-
facturer view is enabled.

Category and Manufacturer Organizes plug-ins 
in two levels of menus. The top menus display 
plug-ins by process category (such as EQ, Dy-
namics, and Delay), with individual plug-ins 
listed in the category submenus. The bottom 
menus display plug-ins by manufacturer (such 
as Bomb Factory, Digidesign, Focusrite, or TL 
Labs), with individual plug-ins listed in the 
manufacturer submenus.

Language Options (Windows Only)

Language Sets the language to use in the 
Pro Tools application, independently of what 
language version of Windows is used.
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Default Automatic Naming to English Causes au-
tomatically named session elements in a session 
to be named in English even when working with 
the Pro Tools application set to another lan-
guage.

Meters Section

Peak Hold Options

These options determine how long the peak in-
dicators on track meters stay lit after a peak is de-
tected. 

3 Seconds When selected, track meters display 
the last peak level for three seconds.

Infinite When selected, track meters display the 
last peak level until you click them to clear 
them.

None When selected, track meters do not hold 
the peak level.

Clip Indication Options

These options determine how long the clip indi-
cators on plug-in, send, and track meters stay lit 
after a clip is detected.

3 Second Clip Hold When selected, meters dis-
play the last clip indication for three seconds.

Infinite Clip Hold When selected, meters display 
the last clip indications until you click them to 
clear them.

No Clip Hold When selected, meters do not hold 
the clip indication.

Show Meters in Sends View

When the Sends View is displaying individual 
send controls, you can select this option to show 
send level meters. Deselecting this option can 
help speed up screen redraws and processing.



Color Coding

Always Display Marker Colors Lets you choose to 
view Marker colors in the Markers ruler, regard-
less of the settings you choose for Default Region 
Color Coding. 

MIDI Note Color Shows Velocity When enabled, 
MIDI notes display varying shades of the as-
signed track color in MIDI notes view in the Edit 
window and in MIDI Editor windows. Notes 
with high velocities are darker and notes with 
lower velocities are lighter.

Default Track Color Coding Options

These color coding options determine the de-
fault color coding assignment for tracks in the 
Edit and Mix windows. The options are:

None Turns off color assignment for tracks.

Tracks and MIDI Channels Assigns a color to 
each track in the Mix or Edit window according 
to its voice assignment or MIDI channel assign-
ment.

Tracks and MIDI Devices Assigns a color to each 
track in the Mix or Edit window according to its 
voice assignment or MIDI device assignment.

Groups Assigns a color to each track according to 
its Group ID. If groups are suspended using the 
Suspend Groups command, the tracks color bars 
are not shown.

Track Type Assigns a color to each track accord-
ing to its type (audio, Auxiliary Input, Master 
Fader, VCA Master, MIDI, Instrument, or 
Video).
Default Region Color Coding Options

These color coding options determine the de-
fault color coding assignment for tracks, Marker 
Locations, and regions residing in the track 
playlist and Region List. The options are:

None Turns off color assignment for regions. Re-
gions are drawn with black waveform or MIDI 
notes on a light gray background.

Tracks and MIDI Channels Assigns a color to 
each region in the Edit window according to its 
voice or MIDI channel assignment.

Tracks and MIDI Devices Assigns a color to each 
region in the Edit window according to its voice 
assignment or MIDI device assignment.

Groups Assigns a color to each region according 
to the Group ID of its track. If groups are sus-
pended using the Suspend Groups command, all 
regions display black waveforms or MIDI notes 
on a light gray background.

Track Color Assigns a region color based on the 
color assigned to the track.

Marker Locations Assigns a unique color to each 
marker area in the Marker ruler, including the 
area preceding the first marker.

Region List Color Assigns a color to each region 
based on its color in the Region List.
Chapter 2: Preferences 7
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Operation Preferences

Transport Section

Timeline Insertion/Play Start Marker Follows 
Playback When selected, the Timeline Insertion 
and the Play Start Marker both move to the 
point in the Timeline where playback stops. 
When deselected, the Timeline Insertion and 
Play Start Marker do not follow playback, but re-
turn to the point in time where playback began.

Edit Insertion Follows Scrub/Shuttle When se-
lected, the edit cursor automatically locates to 
the point where scrubbing stops.

Audio During Fast Forward/Rewind When se-
lected, audio is audible during fast forward or re-
wind.

Latch Forward/Rewind When selected, fast for-
ward and rewind latch and continue until you 
press Stop, Play, Return To Zero, or Go To End 
on the Transport. When disabled, the Fast For-

Press Start+N (Windows) or Control+N 
(Mac) to toggle the Timeline Insertion/Play 
Start Marker Follows Playback preference 
on and off.
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ward and Rewind only last as long as you hold 
down the mouse after clicking either button on 
the Transport (or hold down the corresponding 
switch on a Control Surface).

Play Start Marker Follows Timeline 
Selection When enabled, the Play Start Marker 
snaps to the Timeline Selection Start Marker 
when you move the Timeline Selection, draw a 
new Timeline Selection, or adjust the Timeline 
Selection Start. When disabled, the Play Start 
Marker doesn’t move with the Timeline selec-
tion.

Reserve Voices for Preview in Context (Pro Tools 
HD Only) When enabled, Pro Tools reserves the 
appropriate number of voices for preview in 
context (previewing audio files in DigiBase dur-
ing session playback). The number of available 
voices is reduced by the channel width of the se-
lected audition paths on the Output page of the 
I/O Setup window. For example, if the number 
of playback voices is set to 48 in the Playback 
Engine, and you have a stereo audition path se-
lected in the I/O Setup, only 46 voices will be 
available for tracks. If you have a 5.1 audition 
path, only 42 voices will be available. When this 
option is disabled, you will not be able to pre-
view in context if there are not enough available 
voices. 

Custom Shuttle Lock Speed Sets the highest fast-
forward Shuttle Lock speed (key 9) for Shuttle 
Lock modes (Classic or Transport). The range for 
this setting is 50–800%. 

Back/Forward Amount (Pro Tools HD Only) Sets 
the default length of Back, Back and Play, Forward 
and Forward and Play. The timebase of the 
Back/Forward Amount settings follows the Main 
Time Scale by default, or you can deselect the 
Follow Main Time Scale option and select another 
timebase format: Bars:Beats, Min:Sec, Time 
Code, Feet+Frames, or Samples.



Numeric Keypad Mode

Numeric Keypad mode determines how the nu-
meric keypad functions. You can always use the 
numeric keypad to select and enter values in the 
Event Edit Area, Edit Selection indicators, Main 
and Sub Counters, and Transport fields.

Classic Selects a Shuttle Lock mode that emu-
lates the way Pro Tools worked in versions lower 
than 5.0. With the Numeric Keypad mode set to 
Classic, you can play up to two tracks of audio in 
Shuttle Lock mode. Press the Start key (Win-
dows) or Control (Mac), followed by 0–9 for dif-
ferent play speeds. Press Plus (+) or Minus (–) to 
reverse direction. Recall Memory Locations by 
typing the Memory Location number, followed 
by Period (.). 

Transport Selects a Shuttle Lock mode that lets 
you set a number of record and play functions, 
and also operate the Transport from the nu-
meric keypad. With the Numeric Keypad mode 
set to Transport, you can play up to two tracks of 
audio in Shuttle Lock mode. Press the Start key 
(Windows) or Control (Mac), followed by 0–9 
for different play speeds. Press Plus (+) or Minus 
(–) to reverse direction. Recall Memory Loca-
tions by typing Period (.), the Memory Location 
number, and Period (.) again. 

Shuttle (Pro Tools HD Only) Selects a type of 
shuttling different from that of Shuttle Lock 
mode. With the Numeric Keypad mode set to 
Shuttle, playback is triggered by pressing and 
holding the keys on the numeric keypad—play-
back stops once the keys are released. Various 
playback speeds are available in both forward 
and reverse. You can also recall Memory Loca-
tions by typing Period (.), the Memory Location 
number, and Period (.) again.
Use Separate Play and Stop Keys 

When enabled, this option lets you start play-
back with the Enter key and stop playback with 
the 0 key on the numeric keypad. This is useful 
for quickly starting and stopping playback when 
auditioning loop transitions. The Use Separate 
Play and Stop Keys option is only available in 
Transport Numeric Keypad mode.

Auto Backup Section

Enable Session File Auto Backup When se-
lected, Pro Tools automatically saves backups of 
your Pro Tools session file while you work. Back-
ups are saved to in the Session Files Backup 
folder in your session folder. 

Keep specifies the total number of incremental 
backups that are kept.

Backup Every Specifies how often the session is 
saved.

Video Section

QuickTime Playback Priority Options

Normal This is the default setting for QuickTime 
Playback Priority. It gives no extra priority to 
movie playback over other screen update tasks 
such as metering, moving faders, and so on. In 
most cases you should use this setting.

Medium This setting gives QuickTime movie 
playback a higher priority relative to other 
Pro Tools screen update tasks. Use this setting if 
you experience inconsistent QuickTime movie 
playback with the Normal setting.

When this option is enabled, it overrides us-
ing the Enter key to add Memory Location 
markers. Instead, press Period (.) and then 
Enter on the numeric keypad to add a Mem-
ory Location marker.
Chapter 2: Preferences 9
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Highest This setting gives QuickTime movie 
playback highest priority. In this mode, 
Pro Tools disables screen activity and requires 
you to use the Spacebar to stop playback. Use 
this setting if you require uninterrupted Quick-
Time movie playback.

High Quality QuickTime Image

When enabled, Pro Tools decompresses both 
fields of each interlaced frame of QuickTime 
video. When viewing a QuickTime movie in the 
Pro Tools Video window, select this option to 
display the movie at the highest possible resolu-
tion. Deselecting this option can help improve 
performance if your system experiences prob-
lems playing back a session with QuickTime 
video.

Avid Video Errors Stop Playback

(Pro Tools HD with Avid Video Engine Only)

When selected, Pro Tools automatically stops 
playback of audio and video if a single frame of 
video is dropped.

When not selected, Pro Tools continues play-
back of audio even if frames are dropped. In 
most cases, video playback will recover within a 
few frames and continue playing audio and 
video in sync.

Avid Video NTSC Has Setup (NTSC-J)

(Pro Tools HD with Avid Video Engine Only)

This preference lets you adjust the level of NTSC 
video black output between 7.5 IRE (standard) 
or 0 IRE. When this option is selected, output 
level is 0 IRE.
Preferences Primer
Record Section

Latch Record Enable Buttons When selected, 
multiple audio tracks can be record-enabled. 
When not selected, multiple audio tracks can-
not be record-enabled. Record-enabling an au-
dio track takes all other audio tracks out of 
record-enabled mode.

Link Record and Play Faders When selected, 
Pro Tools does not remember separate fader lev-
els for tracks when they are record-enabled, al-
lowing you to maintain the same monitoring 
level for tracks during recording and playback. 

Audio Track RecordLock (Pro Tools HD 
Only) This option configures Pro Tools tracks to 
either emulate a digital dubber, or to maintain 
legacy behavior for track record status. 

• When selected, the record-enabled audio 
tracks remain record-enabled when play-
back or recording stops. 

• When not selected, record-enabled audio 
tracks are taken out of record enable when 
Pro Tools is stopped. This prevents tracks 
from remaining armed from pass to pass, 
emulating track record behavior of a digital 
dubber. 



Transport RecordLock (Pro Tools HD Only) This 
option lets the Transport Record (the Record 
button in the Transport controls) be configured 
to either emulate a digital dubber, or to main-
tain legacy behavior for the Transport master 
Record. 

• When selected, the Transport Record re-
mains armed when playback or recording 
stops. This saves having to re-arm the 
Transport between takes, emulating digital 
dubber behavior. 

• When not selected, the Transport Record 
disarms when Pro Tools is manually 
stopped or stops due to a loss of time code. 
This replicates standard Pro Tools record-
ing behavior. 

The Transport RecordLock option is automati-
cally disabled and grayed out when Destructive 
Record mode is enabled.

Disable “Input” When Disarming Track (In “Stop”) 
(Pro Tools HD Only) For flexibility, TrackInput 
monitoring can be customized to remain se-
lected regardless of track record status, or to au-
tomatically switch to Auto Input monitoring af-
ter a recording pass. This lets you optimize 
monitoring for a typical dubbing workflow (in 
which you might want tracks to remain in Input 
Only mode until explicitly switched to Auto In-
put monitoring) or a typical music tracking 
workflow (in which leaving a track in Input 
Only monitoring mode after recording can re-
sult in accidental double-monitoring).

• When selected, taking an audio track out of 
record enable (any mode) takes it out of In-
put Only mode, regardless of the global 
monitor mode, and switches it to monitor 
audio from disk only. 

• When not selected, audio tracks remain in 
Input Only monitoring mode until explic-
itly switched to Auto Input monitoring. 
Mute Record-Armed Tracks While Stopped 
(Pro Tools HD Only) This setting determines 
monitor status of record-armed tracks. 

• When selected, Pro Tools mutes all record-
enabled tracks when the transport is 
stopped. Input can still be monitored while 
stopped using the TrackInput Monitor but-
ton.

• When not selected, Pro Tools does not 
mute audio input on record-enabled tracks 
when the transport is stopped.

PEC/Direct Style Input Monitoring (Pro Tools 
HD Only) This option changes the way the Track-
Input monitoring mode is indicated on-screen 
(and on supported control surfaces) to emulate 
“PEC” (playback) and “Direct” (input/bus) indi-
cation on some large format consoles. 

• When not selected, the TrackInput button 
shows the letter “I.” The button remains 
gray to indicate Auto Input mode and 
lights green to indicate Input Only mode.

• When selected, the TrackInput button re-
mains gray and shows the letter “D” to in-
dicated Input Only mode (“Direct”); it 
lights green and shows the letter “P” to in-
dicate Auto Input mode (“Pec” or play-
back).

Automatically Create New Playlists When Loop Re-
cording When selected, copies loop recorded al-
ternate takes to new playlists in the track. This is 
especially useful to prepare for track composit-
ing in Playlists View after loop recording multi-
ple alternate takes.
Chapter 2: Preferences 11
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Online Options

Record Online at Time Code (or ADAT) 
Lock When selected, online recording begins as 
soon as Pro Tools receives and locks to incoming 
time code.

Record Online at Insertion/Selection When se-
lected, online recording begins at the edit cursor 
location. Recording continues until Pro Tools 
stops receiving time code. If you make a selec-
tion, Pro Tools records online for the length of 
the selection. 

Open Ended Record Allocation

This preference determines how much of your 
available hard drive space is allocated for record-
ing.

Use All Available Space When selected, the 
drive’s entire available space is allocated. Gener-
ally, this is a good setting for recording longer 
takes, as it provides the maximum amount of 
drive space. Additionally, when recording mul-
tiple tracks, the files are spread across your drive. 
This can sometimes slow down the recording 
process for hard drives that use certain file sys-
tems, including HFS+ and NTFS.

Limit To Sets the maximum allowable recording 
duration for one take. This can help reduce the 
time it takes to begin recording by allocating 
only a portion of your hard drive. The number 
of minutes specified is allocated for each record-
enabled track. You may want to experiment 
with this number to achieve the recording per-
formance you want. 

If you do not regularly record longer takes, set a 
smaller length (such as a low multiple of the 
song’s total length).
Preferences Primer
DestructivePunch File Length (Pro Tools HD 
Only)

This preference sets the duration of consoli-
dated audio files when preparing tracks for De-
structivePunch mode. The default value for this 
setting is 25 minutes. 

Misc (Miscellaneous) Section

Show Quick Start Dialog When Pro Tools 
Starts When selected, Pro Tools shows the Ses-
sion Quick Start dialog on launch. 

Auto Region Fade In/Out Length (Pro Tools HD 
Only) Sets a default length for fade-ins and fade-
outs automatically applied to region bound-
aries. Using automatic fade-ins and fade-outs 
saves you the trouble of editing to zero-crossings 
or creating numerous rendered fades in order to 
eliminate clicks or pops in playback. Autofades 
are not written to disk. Value range is from 0–10 
ms for the Auto Region Fade In/Out Length setting. 
A value of zero means that no auto-fading will 
occur. The Auto Fade value is saved with the ses-
sion, and is automatically applied to all free-
standing region boundaries until you change it.

Calibration Reference Level (Pro Tools HD 
Only) Sets a default calibration reference level in 
dB when Pro Tools is in Calibration mode. For 
audio interfaces that have trims (such as the 
192 I/O), see the interface’s guide for calibration 
instructions.

Delay Compensation Time Mode (Pro Tools HD 
Only) This option lets you choose whether infor-
mation in the Delay Manager is displayed in 
milliseconds or samples. This option is only 
available when Delay Compensation is enabled 
(Options > Delay Compensation).



Editing Preferences

Regions Section

Region List Selection Follows Edit 
Selection When selected, selecting a region in a 
track also selects it in the Region List. 

Edit Selection Follows Region List 
Selection When selected, selecting a region in 
the Region List causes Pro Tools to highlight 
that region’s occurrence in a track.

Auto-Name Separated Regions When selected, 
Pro Tools automatically names newly separated 
regions by appending a number to the region’s 
name.

“Separate Region” Operates On All Related 
Takes When selected, editing a region with the 
Separate Region command also affects all other 
related takes (recording passes) with the same 
User Time Stamp. This option helps you com-
pare different sections from a group of related 
takes.
Tracks Section

New Tracks Default To Tick Timebase When se-
lected, all new tracks default to ticks. When de-
selected, audio, Auxiliary Input, Master Fader, 
and VCA (Pro Tools HD only) tracks default to 
samples.

Memory Locations Section

Auto-Name Memory Locations When 
Playing When selected, Pro Tools gives new 
Memory Locations default names based on their 
time location in the session. The time units cur-
rently chosen in the View menu determine the 
units for the names. 

Recall Memory Location at Original Track When 
selected, Memory Locations that recall a selec-
tion also recall the track in which the selection 
was made.

Fades Section

Crossfade Preview Pre-Roll This setting specifies 
the amount of pre-roll to be added when you are 
auditioning crossfades in the Fades dialog.

Crossfade Preview Post-Roll This setting speci-
fies the amount of post-roll to be added when 
you are auditioning crossfades in the Fades dia-
log.

QuickPunch/TrackPunch Crossfade Length Spec-
ifies a default length for crossfades created by 
QuickPunch or TrackPunch (Pro Tools HD only) 
recordings. Crossfades occur before the punch 
in and after the punch out. 

Preserve Fades when Editing This option pre-
serves fade-ins and fade outs, and converts sepa-
rated crossfades into corresponding fade-ins and 
fade-outs.
Chapter 2: Preferences 13
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Default Fade Settings

Fade In Selects the default envelope shape for 
fade-ins when using the Smart Tool.

Fade Out Selects the default envelope shape for 
fade-outs when using the Smart Tool.

Crossfade Selects the default envelope shape for 
crossfades when using the Smart Tool.

REX Selects the default envelope shape for fades 
and crossfades between regions (“slices”) in im-
ported REX files.

Zoom Toggle Section

Vertical Zoom Selects either Selection or Last 
Used for the Zoom Toggle Vertical Zoom setting.

Horizontal Zoom Selects either Selection or Last 
Used for the Zoom Toggle Horizontal Zoom setting.

Remove Range Selection After Zooming 
In When selected, the current Edit selection col-
lapses into an insertion point after zoom tog-
gling in. Zoom toggling back out reverts to the 
previous selection.

Track Height Selects Last Used, Medium, Large, 
Extreme, or Fit To Window for the Zoom Toggle 
Track Height setting.

Track View Selects Waveform/Notes, Warp/Notes, 
Last Used, or No Change for the Zoom Toggle 
Track View setting.

To apply a Fade In, Fade Out, or Crossfade 
to an Edit selection using the Default Fade 
settings, and without opening the Fades di-
alog, press Control+Start+F (Windows) or 
Command+Control+F (Mac).
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Separate Grid Settings When Zoomed In When 
selected, this option retains the same (current) 
grid setting when zoom toggling in or out. 
When this option is deselected, the grid setting 
stored with Zoom toggle is recalled when zoom 
toggling in. 

Zoom Toggle Follows Edit Selection When se-
lected, zoom toggle automatically follows the 
current Edit selection. When disabled, changing 
the Edit selection has no affect on the currently 
toggled-in track.

Levels of Undo

This preference sets the maximum number of 
actions that can be undone with the multiple 
undo feature. Setting this to a lower number can 
speed up the performance of slower computers. 
Pro Tools supports up to 32 Levels of Undo.



Mixing Preferences

Setup Section

Sends Default to –INF When selected, the initial 
fader level of newly-created sends is set to –∞ (no 
audible signal level). When not selected, the ini-
tial fader level of newly-created sends is set to 
0 dB.

Send Pans Default to Follow Main Pan When se-
lected, newly created sends have Follow Main Pan
turned on, so the Send Pan controls follow the
pan controls of the track. When not selected,
newly created sends have Follow Main Pan turned
off.

Link Mix and Edit Group Enables When selected, 
this option links enabling and disabling of Mix 
and Edit Groups. For example, enabling Group 
A in the Mix Window automatically enables 
Group A in the Edit window.
Use Absolute Pan Linking (Pro Tools HD 
Only) This option affects behavior of grouped 
pan controls.

• When selected, grouped pan controls do 
not maintain relative offsets when any of 
the grouped pan controls is adjusted. All 
grouped pan controls snap to the absolute 
value of the adjusted control. 

• When not selected, grouped pan controls 
maintain relative offsets when any of the 
linked controls is adjusted.

Default EQ

This preference lets you choose any installed EQ 
plug-in as the default, which makes it available 
for quick assignment, both on-screen and on 
ICON worksurfaces (Pro Tools HD only). On-
screen, the plug-in appears at the top of the In-
sert selector pop-up menu. On ICON worksur-
faces, the plug-in appears first in the list of menu 
choices on the rotary encoders.

Default Dynamics

This preference lets you choose any installed 
Dynamics plug-in as the default, which makes it 
available for quick assignment, both on-screen 
and on ICON worksurfaces (Pro Tools HD only). 
On-screen, the plug-in appears at the top of the 
Insert selector pop-up menu. On ICON worksur-
faces, the plug-in appears first in the list of menu 
choices on the rotary encoders.
Chapter 2: Preferences 15
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Controllers

Edit Window Follows Bank Selection If you are 
using a supported control surface with 
Pro Tools, this option scrolls the Edit window to 
display the selected bank of tracks when you 
switch banks on the control surface, ensuring 
that the current bank is viewable on-screen.

Mix Window Follows Bank Selection If you are 
using a supported control surface with 
Pro Tools, this option scrolls the Mix window to 
display the selected bank of tracks when you 
switch banks on the control surface, ensuring 
that the current bank is viewable on-screen.

“Scroll to Track” Banks Controllers When using 
a control surface (such as D-Control or ProCon-
trol) you can select this option to bank control 
surface faders to a numbered track when using 
the Scroll to Track command.

Always Fill Channel Strips When Banking If you 
are using an ICON worksurface (Pro Tools HD 
only), or other supported Digidesign control 
surface, you can select this option to maximize 
the number of channels displayed when bank-
ing. This setting optimizes the Bank commands 
to prevent the display of a small number of 
channels at the extremes of the surface.

Touch Timeout If you are writing automation in 
Touch mode and you stop moving a non-touch 
sensitive fader or encoder, Pro Tools continues 
to write automation for the Touch Timeout 
value.

After the Touch Timeout period, writing of auto-
mation stops and the automation data returns 
to its previous automation value at the rate spec-
ified in the AutoMatch Time setting.
Preferences Primer
Automation Section

Smooth and Thin Data After Pass When selected, 
Pro Tools automatically smooths and then ap-
plies the specified amount of thinning to the au-
tomation data created in an automation pass. 

Degree of Thinning Specifies the amount of thin-
ning performed on automation data when you 
using the Thin Automation command, or if you 
have selected the Smooth and Thin Data After Pass 
option. 

Plug-in Controls Default to Auto-Enabled When 
selected, all applicable controls of newly added 
plug-ins are enabled for automation. When not 
selected, the controls of newly added plug-ins 
must be manually enabled for automation. 

Suppress Automation “Write To” Warnings 
(Pro Tools HD Only) When selected, Pro Tools 
suppresses the warnings that appear after invok-
ing any of the Write Automation To Start, Selec-
tion, End, or Punch commands and then stopping 
the transport.



Latching Behavior for Switch Controls in 
“Touch” This option determines the behavior of 
switch-type controls (such as mute or plug-in 
bypass) when writing automation in Touch 
mode.

• When selected, controls in Touch mode 
will latch in their current state. If an exist-
ing breakpoint is encountered, writing of 
automation stops. If the transport is 
stopped while writing, the control will 
AutoMatch to the underlying value.

• When not selected, controls in Touch 
mode will not latch. 

Allow Latch Prime in Stop (Pro Tools HD 
Only) When selected and any tracks are in Latch 
mode, any automation-enabled controls on 
those tracks can be set to new values while the 
transport is stopped by touching or moving con-
trols, to prepare for the next automation pass. 

Coalesce when Removing Slaves from VCA Group 
(Pro Tools HD Only) This option determines the 
behavior when removing slave tracks from a 
VCA-controlled group.

• When selected, any automation on the 
VCA Master is automatically coalesced 
(without confirmation) to its slave tracks 
when the tracks are removed from the 
group.

• When not selected, a confirmation dialog 
lets you choose whether or not to coalesce 
the VCA Master automation to the slave 
tracks.
Standard VCA Logic for Group Attributes 
(Pro Tools HD Only) This option determines 
which Mix group attributes may be selected in 
the Group dialog when the group is assigned to 
a VCA Master. 

• When selected, the Main Volume, Mute, 
Solo, Record Enable, and Input Monitoring 
controls on slave tracks follow the VCA 
Master only and are not available to be in-
dependently linked. (This emulates the be-
havior of analog console VCA masters.)

• When deselected, the Main Volume, Mute, 
Solo, Record Enable, and Input Monitoring 
controls follow the VCA Master, but also re-
main available for independent linking 
with groups.

Include Sends in Trim Mode (Pro Tools HD 
Only) This option determines the Trim status of 
Send faders when a track is put in Trim mode.

• When selected, Send faders go into Trim 
mode along with the Main Volume fader. 

• When deselected, the Main Volume fader 
goes into Trim mode, but the Send fader 
stays in the corresponding standard Auto-
mation mode.

Include Control Changes in Undo Queue This op-
tion determines whether certain mixer control 
changes, such as moving a fader or pan control, 
are entered into the Undo queue.

• When selected, mixer control changes ap-
pear in the Undo queue, and are undone if 
any prior operation is undone.

• When deselected, mixer control changes 
will not appear in the undo queue, allow-
ing you to undo other types of operations 
without losing the current mixer settings.

Any set to default operations that affect mixer 
controls will be entered into the Undo queue.
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AutoMatch Time If you are writing automation 
in Touch mode, when you release a fader or con-
trol, writing of automation stops and the auto-
mation data returns to its previous value. The 
rate of return to the previous value is the 
AutoMatch Time. 

AutoGlide Time (Pro Tools HD Only) Specifies 
how quickly Pro Tools transitions (glides) from 
one automation value to another, when 
AutoGlide mode is used.

After Write Pass, Switch To Options

These options select the Automation mode that 
Pro Tools tracks automatically switches to after 
an automation pass in Write (or Write Trim) 
mode. Select one of the following options:

Touch Switches to Touch mode after an automa-
tion pass in Write (or Write Trim) mode.

Latch Switches to Latch mode after an automa-
tion pass in Write (or Write Trim) mode.

No Change Stays in Write mode after an automa-
tion pass in Write (or Write Trim) mode. 

After an automation pass in Write Trim mode, 
tracks automatically switch to the Trim version 
of the specified setting.
Preferences Primer
Coalesce Trim Automation Options

(Pro Tools HD Only)

These options determine when Trim automa-
tion is committed to the main automation play-
list on a track.

After Every Pass Sets Trim automation to coa-
lesce when the transport is stopped at the end of 
each Trim automation pass. No Composite Play-
list is indicated.

On Exiting Trim Mode Sets Trim Automation to 
coalesce on a track when the track is taken out of 
Trim mode. A Composite Playlist can be viewed 
before committing Trim moves.

Manually Trim Automation can be coalesced 
only with the Coalesce Trim Automation com-
mand. A Composite Playlist can be viewed be-
fore committing Trim moves.



Processing Preferences

AudioSuite Section

Use AudioSuite Dither When selected, certain 
AudioSuite™ plug-ins automatically apply 
dither when processing. AudioSuite plug-ins 
that support automatic dithering include: Gain, 
Normalize, Smack!, and Sonic NoNOISE.

Plug-in Specifies the plug-in used for dither pro-
cessing when the Use AudioSuite Dither option is 
selected.

Bit Depth Lets you select a bit depth for the dith-
ered audio (24-bit, 20-bit, 18-bit, or 16-bit).

Import Section

Convert Imported “WAV” Files To AES31/Broad-
castWave When selected, this option applies to 
all newly imported WAV files, making them 
compliant with the AES31/EBU Broadcast stan-
dard.

Automatically Copy Files on Import When se-
lected, all audio files that are imported by drag-
ging and dropping are copied to the current ses-
sion’s Audio Files folder, regardless of whether 
the files need to be converted to the current ses-
sion’s file type, bit depth or sample rate. Addi-
tionally, when selected, the Copy from Source Me-
dia option is automatically enabled in the 
Import Session Data dialog. The Automatically 
Copy Files on Import preference does not affect 
the Import Audio command.

Import REX Files as Region Groups When se-
lected, REX flies are imported as region groups, 
all the underlying slices are imported as individ-
ual regions contained within the region group. 
When this option is not selected, importing REX 
files into a session converts them to the session’s 
audio file format, the individual slices are con-
solidated, and the slice information is used for 
Elastic Audio analysis. These files remain tick-
based after import and conversion. 

Automatically Create Fades When selected, 
crossfades are applied automatically to the 
sliced regions within region groups created by 
importing REX files. If the Import REX Files as Re-
gion Groups option is not selected, the Automati-
cally Create Fades option is not available. 

To change the default fade settings for REX files, 
click the REX button in the Default Fade Settings 
section on the Editing Preferences page.

Drag and Drop From Desktop Conforms to 
Session Tempo

The Drag and Drop From Desktop Conforms to Ses-
sion Tempo options determine whether or not 
REX, ACID, and audio files are imported as tick-
based Elastic Audio and conformed to the ses-
sion tempo.

No Files When enabled, REX and ACID files, 
and all other audio files are not conformed to 
the session tempo when imported by drag and 
drop from Windows Explorer or the Mac Finder. 
They are imported as sample-based files and 
converted to the sessions audio file format.
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REX and ACID Files Only When enabled, only 
REX and ACID files are conformed to the session 
tempo when imported by drag and drop from 
Windows Explorer or the Mac Finder. REX files 
are imported either as tick-based Elastic Audio 
or, if the Import REX Files as Region Groups op-
tion is enabled, as tick-based region groups. 

All Files When enabled, all audio files (including 
REX and ACID files) imported by drag and drop 
from Windows Explorer or the Mac Finder are 
imported as tick-based Elastic Audio and con-
form to the session tempo.

Sample Rate Conversion Quality

The Sample Rate Conversion Quality pop-up 
menu lets you select the default sample rate con-
version quality for importing audio files by drag 
and drop from any DigiBase browser, or Win-
dows Explorer or Mac Finder. The higher the 
quality of sample rate conversion you select, the 
longer Pro Tools will take to process the audio 
file.

TC/E (Time Compression/Expansion) 
Section

TC/E Plug-in Lets you select the plug-in used for 
Time Compression and Expansion when you 
edit audio with the Time Compression/Expan-
sion Trim tool. This Trim tool works by using 
Time Compression/Expansion to match an au-
dio region to the length of another region, a 
tempo grid, a video scene, or other reference 
point. The DigiRack Time Shift plug-in is se-
lected by default.

Default Settings Specifies the default settings 
used by the chosen Time Compression/Expan-
sion plug-in.
Preferences Primer
Elastic Audio Section

These preferences determine Elastic Audio usage 
and settings on new tracks, as well as for pre-
viewing and importing tick-based audio.

Default Plug-in Lets you select any Real-Time 
Elastic Audio plug-in as the default for preview-
ing and importing Elastic Audio. The selected 
default Elastic Audio plug-in is also used when 
new tracks are created with the Enable Elastic Au-
dio on New Tracks option enabled. 

Default Input Gain Lets you attenuate the signal 
input to Elastic Audio plug-ins by 0 to –6 dB for 
preview and import. If you experience clipping 
due to Elastic Audio processing during preview 
or after import, you may want to set the Default 
Input Gain to slightly attenuate the audio signal 
input for Elastic Audio processing. This prefer-
ence also applies to any audio imported to an 
Elastic Audio–enabled track.

The Elastic Properties window inherits the De-
fault Input Gain setting. To apply further region-
based input gain attenuation for Elastic Audio 
processing, select the region and adjust the Input 
Gain setting in the Elastic Properties window .

Enable Elastic Audio on New Tracks When se-
lected, new tracks are created with Elastic Audio 
enabled. The selected default Elastic Audio plug-
in is used.

If the Enable Elastic Audio on New Tracks 
option is selected, you may want to also se-
lect the New Tracks Default to Tick Time-
base option in the Editing Preferences page.



MIDI Preferences

Basics Section

Remove Range Selection After Opening the 
MIDI/Score Editor When selected, the MIDI Edi-
tor and Score Editor open with no Edit selection. 
When this option is disabled, the MIDI Editor 
and Score Editor open with the current Edit se-
lection intact.

Use MIDI to Tap Tempo When enabled, you can 
tap a MIDI keyboard to enter a new tempo value 
into a tempo field.

Display Events as Modified by Real-Time Proper-
ties When enabled, Pro Tools displays the ef-
fects of Real-Time Properties in the Edit, MIDI 
Editor, and Score Editor windows, and the MIDI 
Event List.

Use F11 Key for Wait for Note When enabled, 
pressing the F11 Function key puts MIDI record-
ing in Wait for Note mode. 

Automatically Create Click Track in New 
Sessions When enabled, Pro Tools automati-
cally creates a new click track in new sessions.
Default Thru Instrument

This option lets you set the default MIDI Thru 
instrument. You can select a predefined device 
from your available MIDI instruments, or select 
First Selected MIDI Track to use the assigned MIDI 
output of the first selected MIDI or Instrument 
track. When multiple MIDI or Instrument tracks 
are selected, the instrument in the selected track 
that is closest to the top of the Edit window (or 
closest to the left edge of the Mix window) is 
used. Select None to only route MIDI Thru 
record enabled MIDI and Instrument tracks.

Pencil Tool Resolution When Drawing Controller 
Data

This option lets you set the default resolution 
for MIDI controller data created with the Pencil 
tool. Setting this to a lower resolution helps 
avoid creating controller data that is unneces-
sarily dense. The value range is from 1 to 100 
milliseconds.

Global MIDI Playback Offset

This option lets you set an offset in samples to 
compensate for MIDI latency. Entering a value 
here has the same effect as setting an offset with 
the MIDI Track Offsets command. Offset values 
can be positive (later) or negative (earlier). 
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Double-Clicking a MIDI Region Opens

This option lets you specify what happens when 
you double-click MIDI regions on MIDI and In-
strument tracks in the Edit window. 

MIDI Editor Opens the MIDI region in a MIDI 
Editor window.

Score Editor Opens the MIDI region in the Score 
Editor window.

MIDI Event List Opens the MIDI region in the 
MIDI Event List.

Name Dialog Opens the Name dialog for the 
MIDI region.

Note Display Options

These options set the reference for middle C as 
C3, C4, or MIDI note number 60.
Preferences Primer
Delay for External Devices Section

(Pro Tools HD Only)

These options only apply when a Delay Compen-
sation Engine is selected in the Playback Engine 
dialog and Delay Compensation is enabled in 
Pro Tools. These options are distinct from the 
hardware offsets available for hardware inserts 
in the I/O Setup.

MIDI Time Code When selected, Pro Tools ap-
plies Delay Compensation to Pro Tools-gener-
ated MIDI Time Code (MTC). Enable this option 
when synchronizing video to Pro Tools using 
MTC.

MIDI Beat Clock When selected, Pro Tools ap-
plies Delay Compensation to Pro Tools-gener-
ated MIDI Beat Clock.

MIDI/Score Editor Display

Additional Empty Bars in the Score Editor

This setting lets you specify the default number 
of empty bars that appear in the Score Editor 
window after the end of the last MIDI region in 
the session.



Synchronization Preferences

Machine Control Section

Machine Chases Memory Location When se-
lected, navigating to a specific location in a ses-
sion with a Memory Location causes a con-
nected transport to chase to that location.

Machine Follows Edit Insertion/Scrub When se-
lected, navigating to a specific location in a ses-
sion by moving the selection point or by scrub-
bing a track will cause a connected transport to 
chase to that location.

When the connected device is a linear device 
(such as a tape deck), select Linear Devices (jog) to 
set Pro Tools to send jog commands.

When the connected device is a non-linear de-
vice (such as a random-access video recorder or 
another Pro Tools system), select Non-Linear De-
vices (cue) to set Pro Tools to send cue com-
mands.
Machine Cues Intelligently (Pro Tools HD 
Only) When selected, if you navigate to a cue 
point that is more than 10 seconds from the cur-
rent location, Pro Tools will command a con-
nected transport to fast wind to the new loca-
tion at full speed to within 10 seconds of the cue 
point. Cueing will then slow to normal speed 
until the point is reached. This can significantly 
speed up tape cueing with certain video trans-
ports.

Stop at Shuttle Speed Zero (Pro Tools HD 
Only) Causes Pro Tools to send a Stop command 
whenever you stop shuttling. This is useful if 
you have a machine that requires an explicit 
stop command to park correctly. 

Non-Linear Transport Error Suppression (Pro Tools 
HD Only) When Transport = Pro Tools, keeps 
Pro Tools from sending a Stop command when 
taken offline. This prevents Pro Tools from stop-
ping any other 9-pin devices connected to the 
system.

Synchronization Section

Minimum Sync Delay Sets the initial amount of 
prime time (in frames) your system’s devices 
need to achieve synchronization “lock.” This 
amount varies for each device. Pro Tools lock up 
delay is set by entering a value for Minimum Sync 
Delay in the Synchronization page of the Prefer-
ences dialog. The lowest value available is 15 
frames. Find the shortest possible lock-up time 
that your equipment can operate at consis-
tently, and set this as the Minimum Sync Delay. 
On systems using Digidesign MachineCon-
trol™, enabling the Use Serial Time Code option 
will make machines lock up much faster. (Serial 
time code requires both a Digidesign-qualified 
synchronization peripheral and external devices 
to be locked to house video reference.)
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Delay Before Locking to Longitudinal Time Code 
(Pro Tools HD Only) Sets the amount of time (in 
frames) for Pro Tools to lock to incoming LTC. 
Use this option when locking Pro Tools to a sta-
ble time code source (such as a non-linear tape 
machine or LTC generator) and not a linear tape 
machine.

Delay Before Locking to Serial Time Code 
(Pro Tools HD Only) Sets the amount of time (in 
frames) for Pro Tools to wait before attempting 
to lock to machines that issue servo lock mes-
sages. This setting allows time for the servo 
mechanisms to achieve stable lock.

Remote Mode Section

(Pro Tools HD Only)

Ignore Track Arming Sets Pro Tools to ignore in-
coming track arming (record enable) com-
mands. This is useful if you are using a master 
controller to arm tracks on other machines, but 
you do not want to arm tracks in Pro Tools.

Set Servo Lock Bit at Play (Tamura Support) En-
able this option when using a Tamura synchro-
nizer to control Pro Tools in Remote mode to 
minimize lock-up times during recording.

Allow Track Arm Commands in Local Mode Sets 
Pro Tools to respond to incoming track arming 
(record enable) commands even when the sys-
tem is not in Remote mode. This is useful if you 
are using a paddle device to control Pro Tools 
track arming or punching. 

Punch In Frame Offset Sets an offset (in frames) 
to compensate for punch in timing advances or 
delays.

Punch Out Frame Offset Sets an offset (in frames) 
to compensate for punch out timing advances 
or delays.
Preferences Primer
Delay After Play Command Sets the amount of 
time (in frames) for Pro Tools to wait after re-
ceiving a Play command before starting the au-
dio engine. This can prevent false starts when 
locking to synchronizers that are not fully sup-
ported by Pro Tools.

Satellite Link Section

(Pro Tools HD Only)

These preferences are only available with the 
Satellite Link option. The Pro Tools Satellite 
Link option lets you link up to 5 Pro Tools sys-
tems (or 4 Pro Tools systems and an Avid® Me-
dia Composer® with the Video Satellite option 
or a Video Satellite LE system) over an Ethernet 
network so that you can cue, play, and stop the 
transport, make play selections, and solo tracks 
across any of the systems from any linked work-
station.

Transmit Solos Causes a linked Pro Tools system 
to send the solo status of its tracks to all other 
linked Pro Tools systems. On other linked sys-
tems that are set to receive solos, tracks follow 
solo behavior as if the solo were on the local sys-
tem. 

Receive Solos Causes a linked Pro Tools system 
to receive solos from all other linked Pro Tools 
systems that are set to transmit solo status of 
their tracks. Tracks on the receiving system fol-
lows solo behavior as if the solos were on the lo-
cal system. 

Solo Independent of Linked State Causes a 
Pro Tools system to send the solo status of its 
tracks to other satellite systems even when it is 
unlinked. This allows control of solo status 
across systems even when transport control is 
not enabled. 



DAE Errors Stop All Linked Systems Causes a 
DAE error on any linked Pro Tools system to 
stop the transport on all linked systems. When 
this option is not selected, linked systems will 
not stop if a DAE error occurs on one system. 

Transmit Play Selections Causes a linked 
Pro Tools system to send the Edit window selec-
tion to all other linked Pro Tools systems. On 
other linked systems that are set to receive play 
selections, the selection is mirrored in the Edit 
window.

Receive Play Selections Causes a linked 
Pro Tools system to receive Edit window selec-
tions from all other linked Pro Tools systems 
that are set to transmit play selections.
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chapter 3

Noting Your Preferences
When you upgrade your Pro Tools software, 
preferences are reset to their default settings. 
The default settings may differ from your exist-
ing preferences settings. Therefore, you may 
want to note your current preferences settings 
before upgrading. 

To note your current Preferences settings, you can 
do one the following:

Take a picture, a screenshot, of the existing 
tabbed pages in the Preferences dialog. See “Tak-
ing Screenshots of Your Preferences Pages” on 
page 27.

– or –

Note your preference settings using the tables 
provided here. See “Preference Tables” on 
page 29.
Taking Screenshots of Your 
Preferences Pages
Mac and Windows both offer the capability of 
taking a screenshot of whatever appears on your 
computer screen. Follow the instructions below 
for your computer platform.

Taking Screenshots on a Mac

Use the Mac application Grab to take and save 
your screenshots.

To take screenshots of your Preferences pages on 
a Mac:

1  Open Pro Tools and choose Setup > Prefer-
ences.

2  Open the Grab application on your Mac.

3  In Grab, choose Capture > Window.

4  When the Window Grab dialog opens, click 
Choose Window.

5  Click the Preference dialog to take the screen-
shot.

6  In Grab, choose File > Save As to name and 
save the screenshot.

7  Repeat this procedure for each tabbed page in 
the Preferences dialog.
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Taking Screenshots in Windows

Use the Print Screen key on your keyboard to 
take your screenshots, and use the Paint applica-
tion to save them.

To take screenshots of your Preferences pages in 
Windows:

1  Open Pro Tools and choose Setup > Prefer-
ences.

2  Press the Print Screen key on your computer’s 
keyboard.

3  Open the Paint application.

4  In Paint, choose Edit > Paste.

5  After the screenshot appears in Paint, choose 
File > Save As to name and save the screenshot.

6  Repeat this procedure for each tabbed page in 
the Preferences dialog.
Preferences Primer



Preference Tables

Display Preferences

Preference Setting

Basics

Track Position Numbers 
Stay with Hidden Tracks

Tools Tips

Function

Details

Edit Window Default Length

Organize Plug-in Menus By

Flat List

Category

Manufacturer

Category and Manufactur-
er

Language

Default Auto-naming to 
English (ASCII)

Meters

Peak Hold

3 Seconds

Infinite

None

Clip Indication

3 Seconds

Infinite

None
Color Coding

Always Display Marker Col-
ors

Midi Note Color Shows 
Velocity

Default Track Color Coding;

None

Tracks and MIDI Channels

Tracks and MIDI Devices

Groups

 Track Type

Default Region Color Coding

Tracks and MIDI Channels

Tracks and MIDI Devices

Track Color

Groups

Marker Locations

Region List Color

Preference Setting
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Operation Preferences

Preference Setting

Transport

Timeline Insertion/Play 
Start Marker Follows Play-
back

Edit Insertion Follows 
Scrub/Shuttle

Audio During Fast 
Forward/Rewind

Latch Forward/Rewind

Play Start Marker Follows 
Timeline Selection

Reserve Voices for Preview 
in Context (Pro Tools HD)

Custom Shuttle Lock Speed

Back/Forward Amount 
(Pro Tools HD)

2 seconds

5 Seconds

10 Seconds

15 Seconds

20 Seconds

30 Seconds

Bars|Beats

Min:Secs

Time Code

Feet+Frames

Samples

Follow Main Time Scale
Preferences Primer
Numeric Keypad

Classic

Transport

Shuttle

Use Separate Play and Stop 
Keys

Auto Backup

Enable Session File Auto 
Backup

Keep

Every

Video

Quick Time Playback Priority

Normal

Medium

Highest

High Quality QuickTime 
Image

Avid Video Errors Stop Play-
back (Pro Tools HD with 
Avid Video Engine Only)

Avid Video NTSC Has Setup 
(NTSC-J) (Pro Tools HD with 
Avid Video Engine Only)

Preference Setting



Record

Latch Record Enable But-
tons

Link Record and Play Faders

Audio Track RecordLock 
(Pro Tools HD)

Transport RecordLock 
(Pro Tools HD)

Disable “Input” When Dis-
arming Track (In “Stop”) 
(Pro Tools HD)

Mute Record-Armed Tracks 
While Stopped 
(Pro Tools HD)

PEC/Direct Style Input Mon-
itoring (Pro Tools HD)

Automatically Create New 
Playlists When Loop 
Recording

Online Options

Record Online at Time 
Code (or ADAT) Lock

Record Online at Inser-
tion/Selection

Open-Ended Record Alloca-
tion

Use All Available Space

Limit to

Destructive Punch File 
Length

Preference Setting
Misc.

Show Quick Start dialog 
when Pro Tools Starts

Auto Region Fade In/Out 
Length

Calibration Reference Level

Delay Compensation Time 
Mode

Samples

Seconds

Preference Setting
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Editing Preferences

Preference Setting

Regions

Region List Selection Fol-
lows Edit Selections

Edit Selection Follows 
Region List Selection

Auto-Name Separated 
Regions

“Separate Region” Opera-
tions on All Related Takes

Tracks

New Tracks Default to Tick 
Timebase

Memory Locations

Auto-Name Memory Loca-
tions when Playing

Fades

Crossfade Preview Pre-Roll

Crossfade Preview Post-Roll

QuickPunch/TrackPunch 
Crossfade Length

Preserve Fades when Edit-
ing

Default Fade Settings

Fade In...

Fade Out...

Crossfade...

REX...
Preferences Primer
Zoom Toggle

Vertical Midi Zoom

selection

last used

Horizontal Zoom

selection

last used

Remove Range Selection 
After Zooming In

Tack Height

last used

medium

large

jumbo

extreme

fit to window

Track View

waveform/notes

warp/notes

last used

no change

Separate Grid Settings 
When Zoomed In

Zoom Toggle Follows Edit 
Selection

Levels of Undo

Preference Setting



Mixing Preferences

Preference Setting

Setup

Sends Default to “–INF”

Send Pans Default to Follow 
Main Pan

Link Mix/Edit Groups 
Enables

Use Absolute Pan Linking

Default EQ

none

TDM plug-in

RTAS® plug-in

Default Dynamics

none

TDM plug-in

RTAS plug-in

Automation

Smooth and Thin Data After 
Pass

Degree of Thinning

none 

little

some

more

most

Plug-in Controls Default to 
Auto-Enabled

Suppress Automation 
“Write To...” Warnings
Latching Behavior for 
Switch Controls in “Touch”

Allow Latch Prime in Shop

Coalesce when Removing 
Slaves from VCA Group

Standard VCA Logic for 
Group Attributes

Include Sends in Trim Mode

Include Control Changes in 
Undo Queue

AutoMatch Time

AutoGlide Time

After Write Pass, Switch To

Touch

Latch

No Change

Coalesce Trim Automation

After Every Pass

On Existing Trim Mode

Controllers

Edit WIndow Follows Bank 
Selection

Mix Window Follows Bank 
Selection

“Scroll to Track” Banks Con-
trollers

Always Fill Channel Strips 
when Banking

Touch Timeout

Preference Setting
Chapter 3: Noting Your Preferences 33



34
Processing Preferences

Preference Setting

AudioSuite

Use AudioSuite Dither

Plug-in

Bit Depth

16 Bits

18 Bits

20 Bits

24 Bits

Import

Convert Imported “.wav” 
Files to AES31/Broadcast 
Wave

Automatically Copy Files on 
Import

Import REX Files as Region 
Groups

Automatically Create 
Fades

Drag and Drop from Desk-
top Conforms to Session 
Template

No Files

REX and ACID Files Only

All Files

Sample Rate Conversion 
Quality
Preferences Primer
TC/E

TC/E Plug-in

Default Settings

Elastic Audio

Default Plug-in

Polyphonic

Rhythmic

Monophonic

Varispeed

Default Input Gain

Enable Elastic Audio on 
New Tracks

Preference Setting



MIDI Preferences
 

Preference Setting

Basics

Remove Range Selection 
After Opening the 
MIDI/Score Editor

Use MIDI to Tap Tempo

Display Events as Modified 
by Real-Time Properties

Use F11 Key for Wait for 
Note

Automatically Create Click 
Track in New Sessions

Default Thru Instrument

Pencil Tool Resolution when 
Drawing Controller Data

Global MIDI Playback Offset 
(-10,000 to 10,000)

Double-clicking a MIDI 
Region Opens

MIDI Editor

Score Editor

MIDI Event List

Name Dialog
Note Display

Standard Pitch Middle

Alternate Pitch Middle

MIDI Note Number

Delay Compensation for 
External Devices

MIDI Time Code

MIDI Beat Clock

MIDI/Score Editor Display

Additional Empty Bars in 
the Score Editor

Preference Setting
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Synchronization Preferences

Preference Setting

Machine Control

Machine CHases Memory 
Locations

Machine Follows Edit/Inser-
tion Scrub

Linear Devices (jog)

Non-Linear Devices (cue)

Machine Cues Intelligently

Stop at Shuttle Speed Zero

Non-Linear Transport Error 
Suppression

Synchronization

Minimum Sync Delay

Delay before Locking to Lon-
gitudinal Time Code

Delay before Locking to 
Serial Time Code

Remote Mode

Ignore Track Arming

Set Servo Lock Bit at Play

Allow Track Arm Commands 
in Local Mode

Punch in Frame Offset

Punch Out Frame Offset

Delay after Play Command
Preferences Primer
Satellites

Transmit Solos

Receive Solos

Solo Independent Of Linked 
State

DAE Errors Stop All Linked 
Systems

Transmit Play Selections

Receive Play Selections

Preference Setting
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